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FrontPage Exercises 1 – Getting Started 
About FrontPage 
Microsoft FrontPage is a program that is used for creating and editing websites. It is 
designed to be familiar to users of word processing software such as Microsoft Word. 
The key difference between a word processor and a website editor is that a word 
processor works with individual documents. A website editor works with a website 
which is a collection of documents. Many people make the mistake of using 
FrontPage the same way they would use a word processor and miss out on some of its 
best features as a result. 

Using the FrontPage Window 
When you first open Microsoft FrontPage, you will see a screen similar to the one 
below 
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In the following exercises, you will create a small website about yourself usin
FrontPage 2002. In the process, you will learn about a lot of FrontPage’s most usefu
features. 

Creating a Web 
The first thing to do is to create a new web (FrontPage’s term for a grouped collectio
of documents that make up the website). If the task pane is not showing on the right o
your screen, go to the File menu and choose New, Page or Web. From the options 
the Task pane, click on Empty Web. A dialog box like the one on the following pag
will appear. 
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The first thing to do is specify where your website will be stored. In the location box, 
you can browse for a location or type in a location. For this site, make sure it is saved 
in your personal folder with the name of the website at the end.  
E.g. H:\Year 11 Bit\06 Task 5 - Portfolio\Me\  (“Me” would be the name of the website) 
Once the location is specified, make sure One Page Web is selected and click OK. 
FrontPage will then create a new web which includes a new file called index.htm. 
Note: all web files have file names ending with either .htm or .html – it is normal for 
the main page in a site to be called index. It is also a good idea to avoid uppercase 
letters and spaces in filenames for websites (this includes any pictures that will go in 
your site). 
The folder list should now appear to the left of 
your screen. This can be used to quickly open 
the files that make up your website. If the 
folder list is not showing you can display it by 
clicking the  icon. 
From here you have several options for 
creating the rest of your site. One way is to 
individually create all of the pages and then 
link them up manually later. A far simpler way 
is to use the navigation view to create the structure for the site. Click the 
navigation button from the Views bar on the left. 
Your screen will now show a view with all the pages in your website. Currently there 
will only be the index page. You can re-label it to something more descriptive in one 
of several ways. While it is already selected you can click on the name to edit the 
label. You can also do this by pressing [F2] or by right clicking and selecting 
Rename. Use one of these methods to rename it so it is labelled “Home”. It should 
now look like the button shown below. 
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Adding Pages 
The next thing we will do is add four pages underneath the Home page. These will be 
a Bio page (for general information about yourself), a Hobbies page (for information 
about your hobbies) a Music page (for what music you like) and a Links page (for 
links to your favourite site). 
Make sure the Home page is selected from within the Navigation View. On your 
toolbar, click the Create a normal new page icon  (which should be the very first 
icon on the toolbar). This will add a new page underneath the Home page. With the 
Home page still selected, click the same icon three more times so that you have four 
pages under the home page. Now rename each of those so that they are called, Bio, 
Hobbies, Music and Links. Your Navigation should now look like the navigation view 
shown below. 

 
 
Click the Refresh icon  on the toolbar to update the Folder 
list so that it shows the new pages in case it hasn’t already 
updated the list. 
Note: if you accidentally add too many pages you can select 
any extra ones and press the [Delete] key to remove them. 
You can also re-arrange any page in the navigation view by 
dragging it. If your folder list hasn’t given your pages the right 
filenames (for example if one of them has been called 
something like “page1.htm) you can rename them in the same way you change the 
labels in the navigation view. Just make sure that the filenames all have .htm or .html 
on the end of them. 
Creating the structure of the website using the Navigation view instead of simply 
creating the new pages one at a time has several benefits as you will see later. 

© Steve O’Neil 2005 Page 3 of 8 http://www.oneil.com.au/pc/ 



FrontPage Exercises Part 1  Getting Started 

Editing the pages 
You can open a page for editing in a number of different ways. One way is to double-
click the page icon in the Navigation view. Also, you can double-click and file from 
the folder list to open it. Double click Home in your navigation view or index.htm in 
your folder list to open you main page for editing. This will take you straight to the 
page view, which is where individual pages can be edited similar to a word processor. 
Double-click bio.htm from the folder list so that will also be open. Remember that in 
FrontPage there is nothing wrong with having several pages open at once. Each file 
that is currently being edited will have a small pencil on its icon in the Folder List. 
There will also be a tab for each open file at the top of the Page View.  

 
To close a page that is currently being edited, you can click the small close icon  in 
the top right of the page view (not the one at the top right or the FrontPage window as 
this closes the whole program). Click it now to close the Bio page. You should still 
have the home page (index.htm) open. Type the following text – “Welcome to my 
website”. A * will appear in the tab at the top of the page view to indicate that 
changes have been made since this page was last saved. Click the Save icon  now to 
save the changes and the * will disappear. 
We’ll do some more page editing later but for now, we’ll continue to set up the 
structure of the whole site. 
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Adding Shared Borders 
Shared borders allow you to make full advantage of the website structure that we have 
set up in the Navigation View. Shared borders allow you to add content on the edge of 
your pages that will be the same across the whole site. Any changes made within a 
shared border will affect al pages which have the shared border. This is very handy if 
you want all of your pages to have consistent headings, footers, navigation etc. 
From the Format menu choose Shared Borders. A dialog like the following will 
appear. 

 
Make sure Apply to: is set to All pages. Ensure that there is a tick next to Top, Left 
and Bottom so that these edges of the pages will all have shared borders. Also, make 
sure that the left border has the navigation buttons option selected as shown above. 
Click OK. 
Your page will now have shared borders as shown below. 

 
If you want to have different shared borders or no shared borders on a particular page, 
simply open that page and use the above options with Apply to: set to Current Page. 
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Editing Navigation Bars 
You will notice that a navigation bar has been added to the left shared border. Double-
click the bio.htm page to open is and you will notice that this page also has the same 
shared borders, except that there are no links in the navigation bar. Instead there is a 
message about editing the properties for the link bar. If you move you mouse over that 
text, you mouse pointer will change to indicate that this is a special FrontPage 
component that you can edit. Double-click it to bring up the Navigation Bar 
properties. 

 
 
These properties allow you to specify what information is shown in the navigation 
bar, which is based on what has been set up in the website’s Navigation View. 
Currently it is set to only show links to pages that are below the current page. This is 
why the Home page is the only one with links in its navigation bar, since none of the 
other pages have anything below them in the navigation structure. Instead of Child 
Level, select Child Pages under Home. This will ensure that all the pages below the 
Home page will appear in the navigation bar. Select Home Page as well to ensure that 
this appears in the navigation bar on each page. Click OK when done to update the 
navigation bar. The navigation bar should now look like the one shown below. 
 

 
 
You can open any of the other pages to see that they also have the shared borders and 
navigation bar. Each of the links in the navigation bar takes its text from the labels in 
the navigation view. If you rename a page in navigation view, that will automatically 
change the navigation bars. Any pages, moved, deleted or added in navigation view 
will also update the navigation bars.  
Note: if any of the pages such as the home page are already open, they may not show 
changes to shared borders until you click the Refresh icon . 
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Adding Page Banners 
The Page banner feature allows you to insert a heading in to a shared border, which of 
course will mean that the heading will appear on each page. Of course you could 
simply type headings for each page yourself, but the page banner feature uses the 
page names from your Navigation View so that each page will be given an 
appropriate heading. 
Since we will be editing a shared border, it doesn’t matter which of the pages you 
work on. In the top shared border there is a comment (indicated by the purple text). 
Select and delete this comment so that the top shared border is empty. From the 
Insert menu select Page Banner. The following Dialog will appear. 
 

 
 
Leave the Properties on Picture. This will mean that when a FrontPage Theme is used 
as we will do later, the text in the banner will be replaced with a fancy graphical 
heading. You can enter your own text for the banner down the bottom but leave this 
alone so that it uses the page names from the Navigation View instead. Click OK. 
Click the centre align icon  so that the heading is aligned in the centre of the page. 
Check each of the pages to see that they all have a page heading on them. We can 
worry about the formatting for the heading later. 

Adding Dates 
You can have the current date automatically inserted in to a page every time you 
change it. We’ll add a footer in the bottom page border which shows when the page 
was last modified. Click in the bottom page border for any of the pages you have open 
and delete the comment. Press Enter to leave a blank line and type the following text: 
 
Last updated 
 
Leave a blank space after this text, then go to the Insert menu and select Date and 
Time. 

 
You can change the date formatting if you like and then click OK. Centre align the 
text once you are done and save the page. 
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Previewing the Site 
To see how your website will look in a regular Web Browser, FrontPage has a built-in 
web browser (based on Microsoft Internet Explorer). It is useful to preview you pages 
regularly since not everything in the page view is exactly as it will appear in a 
browser. For example, comments on the page and dividing lines marking shared 
borders will only appear while you are in page view but not in a web browser. 
At the bottom of the screen there are three buttons for changing editing views. 

 
Click the Preview button to see how your page would look in a web browser. Click 
some of the links in the navigation bar to see how the other pages look. Click the 
Normal button at the button to return to your normal editing view. 
Note: because you can’t edit the page while it is being previewed, many of the menu 
options won’t be available while you are in preview mode. 

Viewing the Source Code 
Websites are based on HTML (HyperText Markup Language). FrontPage allows you 
to view and edit the HTML code that is used to make up your pages. Click the HTML 
button at the bottom of the screen to view the source code. It should look similar to 
the following. 
 

 
 
It’s not as complicated as it looks but you don’t need to worry about what it all means. 
FrontPage handles the HTML for you. There are advantages to knowing HTML but 
for basic web page editing, there’s no need to go delving in to the source code. Click 
the Normal button at the button to return to your normal editing view. 
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